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About This Document

This document explains how to install and configure the BEA WebLogic Adapter for PeopleSoft 
8. 

This document is organized as follows:

Chapter 1, “Installing the BEA WebLogic Adapter for PeopleSoft 8,” explains how to 
install the adapter.

Chapter 2, “Installing the Component Interfaces,” explains how to install and configure the 
PeopleSoft component interfaces.

Chapter 3, “Installing and Configuring the BEA TCP/IP Message Router,” explains how to 
install and configure the BEA TCP/IP Message Router to enable PeopleSoft events.

Who Should Read This Documentation
This document is intended for the following members of an integration team:

Integration Specialists—Lead the integration design effort. Integration specialists have 
expertise in defining the business and technical requirements of integration projects, and in 
designing integration solutions that implement specific features of WebLogic Integration. 
The skills of integration specialists include business and technical analysis, architecture 
design, project management, and WebLogic Integration product knowledge.

Technical Analysts—Provide expertise in an organization’s information technology 
infrastructure, including telecommunications, operating systems, applications, data 
repositories, future technologies, and IT organizations. The skills of technical analysts 
include technical analysis, application design, and information systems knowledge.
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Enterprise Information System (EIS) Specialists—Provide domain expertise in the systems 
that are being integrated using WebLogic adapters. The skills of EIS specialists include 
technical analysis and application integration design.

System Administrators—Provide in-depth technical and operational knowledge about 
databases and applications deployed in an organization. The skills of system administrators 
include capacity and load analysis, performance analysis and tuning, deployment 
topologies, and support planning.

Background Knowledge

This document assumes that you have an understanding of:

Web technologies

WebLogic Integration 

PeopleSoft software, system, and environment. This includes understanding of PeopleSoft 
tools and configuration as well as processes and data models.

Your specific PeopleSoft business needs and applications.

Additional Information
To learn more about the software components associated with the adapter, see the following 
documents:

BEA WebLogic Adapter for PeopleSoft 8 Release Notes

http://edocs.bea.com/wladapters/peoplesoft/docs81/pdf/relnotes.pdf

BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide

http://edocs.bea.com/wladapters/peoplesoft/docs81/pdf/install.pdf

BEA Application Explorer Installation and Configuration Guide

http://edocs.bea.com/wladapters/bae/docs81/index.html

Introduction to the BEA WebLogic Adapters

http://edocs.bea.com/wladapters/docs81/index.html

BEA WebLogic Adapters 8.1.0 Dev2Dev Product Documentation

http://edocs.bea.com/wladapters/peoplesoft/docs81/pdf/relnotes.pdf
http://edocs.bea.com/wladapters/bae/docs81/index.html
http://edocs.bea.com/wladapters/docs81/index.html
http://edocs.bea.com/wladapters/peoplesoft/docs81/pdf/install.pdf
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http://dev2dev.bea.com/products/product.jsp?highlight=wla

Application Integration documentation

Introducing Application Integration

http://edocs.bea.com/wli/docs81/aiover/index.html

Using the Application Integration Design Console

http://edocs.bea.com/wli/docs81/aiuser/index.html

BEA WebLogic Integration documentation

http://edocs.bea.com/wli/docs81/index.html

BEA WebLogic Platform documentation

http://edocs.bea.com/platform/docs81/index.html

PeopleSoft documentation

www.peoplesoft.com

Contact Us!
Your feedback on the BEA WebLogic Adapter for PeopleSoft 8 documentation is important to 
us. Send us e-mail at docsupport@bea.com if you have questions or comments. Your comments 
will be reviewed directly by the BEA professionals who create and update the BEA WebLogic 
Adapter for PeopleSoft 8 documentation.

In your e-mail message, please indicate that you are using the documentation for BEA WebLogic 
Adapter for PeopleSoft 8 and the version of the documentation.

If you have any questions about this version of BEA WebLogic Adapter for PeopleSoft 8, or if 
you have problems using the BEA WebLogic Adapter for PeopleSoft 8, contact BEA Customer 
Support through BEA WebSUPPORT at www.bea.com. You can also contact Customer Support 
by using the contact information provided on the Customer Support Card which is included in the 
product package.

When contacting Customer Support, be prepared to provide the following information:

Your name, e-mail address, phone number, and fax number

Your company name and company address

Your machine type and authorization codes

The name and version of the product you are using

http://dev2dev.bea.com/products/product.jsp?highlight=wla
http://edocs.bea.com/wli/docs81/aiover/index.html
http://edocs.bea.com/wli/docs81/aiuser/index.html
http://edocs.bea.com/wli/docs81/index.html
http://edocs.bea.com/platform/docs81/index.html
http://www.peoplesoft.com
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A description of the problem and the content of pertinent error messages



BEA WebLogic Adapter for PeopleSoft 8 Installation Guide 1-1

C H A P T E R 1

Installing the BEA WebLogic Adapter 
for PeopleSoft 8

This section explains how to install the BEA WebLogic Adapter for PeopleSoft 8 with WebLogic 
Integration on both Windows and UNIX systems. 

This section is organized as follows:

Preparing to Install the Adapter

Understanding the Representation of Paths

Installing the Adapter

Next Steps
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Preparing to Install the Adapter
Before you install the BEA WebLogic Adapter for PeopleSoft 8, be sure to complete the 
following tasks:

Review the Release Notes

Understanding the Representation of Paths

Review the Release Notes
The BEA WebLogic Adapter for PeopleSoft 8 Release Notes contain important information about 
the software you must install prior to installing the BEA WebLogic Adapter for PeopleSoft 8. 
Also, be sure to check the release notes for information about any required patches for your 
system. The BEA WebLogic Adapter for PeopleSoft 8 Release Notes are available at the following 
URL:

http://edocs.bea.com/wladapters/docs81/pdf/relnotes.pdf

Understanding the Representation of Paths
When you install WebLogic Integration, you specify the locations for files. Some of these files 
are required by the adapter. This document uses the following conventions to represent the 
locations of these files.

BEA_HOME represents the BEA Home directory of your WebLogic installation. For 
example:

– If you install the product in the default location on a Windows system, BEA_HOME 
represents c:\bea.

– If you install the product in the default location on a UNIX system, BEA_HOME 
represents /bea.

WLI_HOME represents the root of your WebLogic Integration installation. For example:

– If you install WebLogic Integration in the default location on a Windows system, 
WLI_HOME represents c:\bea\weblogic81\integration.

– If you install WebLogic Integration in the default location on a UNIX system, 
WLI_HOME represents /bea/weblogic81/integration.

domain is used to indicate the name of a domain. 

http://edocs.bea.com/wladapters/docs81/index.html
http://edocs.bea.com/wladapters/docs81/index.html
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You use the Configuration Wizard to create custom user domains. When you set up the 
domain configuration with the Configuration Wizard, you must specify a domain name, 
domain. You must also indicate where the directory associated with this domain is created. 
This directory contains files required for that domain. To learn more about the 
Configuration Wizard, see Creating WebLogic Configurations Using the Configuration 
Wizard which is available at the following URL:

http://edocs.bea.com/platform/docs81/confgwiz/index.html 

DOMAIN_HOME represents the complete path to the root of a domain.

For example, if you use the Configuration Wizard to create a domain in the default location 
on a Windows system, DOMAIN_HOME represents 
c:\bea\weblogic81\user_projects\domains\domain.

If you use the Configuration Wizard to create a domain in the default location on a UNIX 
system, DOMAIN_HOME represents /bea/weblogic81/user_projects/domains/domain.

Note: WLI_HOME and BEA_HOME (italicized) also represent the corresponding Windows and 
UNIX environment variables. For example, the literal interpretation of WLI_HOME is 
%WLI_HOME% for Windows and $WLI_HOME for UNIX.

Installing the Adapter 
This section explains how to install the BEA WebLogic Adapter for PeopleSoft 8 with WebLogic 
Integration. It includes the following steps:

Step 1. Obtain the BEA WebLogic Adapter for PeopleSoft 8

Step 2. Configure the Domain

Step 3. Extract the Adapter Files and Change the WebLogic Script

Step 4. Update the BEA License

Step 5. Deploy the Adapter

Step 6. Create an Adapter Administrative User

Step 1. Obtain the BEA WebLogic Adapter for PeopleSoft 8
To obtain the EAR file containing the BEA WebLogic Adapter for PeopleSoft 8 software 
(BEA_PEOPLESOFT_8_1.ear), do one of the following:

Download the file from the following URL:

http://edocs.bea.com/platform/docs81/confgwiz/index.html 
http://edocs.bea.com/platform/docs81/confgwiz/index.html
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http://commerce.bea.com/products/weblogicadapters/wl_adapter_home.jsp

Obtain the software on CD.

Step 2. Configure the Domain
You must deploy the BEA WebLogic Adapter for PeopleSoft 8 in a domain that supports 
application integration functionality. You can create one of your own, or use the sample 
integration domain. The sample integration domain is:

On Windows: BEA_HOME\weblogic81\samples\domains\integration

On UNIX: BEA_HOME/weblogic81/samples/domains/integration

If you have not already done so, use the Configuration Wizard to create the domain. Select the 
Integration domain template.

To learn more about the Configuration Wizard, see the Creating WebLogic Configurations Using 
the Configuration Wizard at the following URL:

http://edocs.bea.com/platform/docs81/confgwiz/index.html

Step 3. Extract the Adapter Files and Change the WebLogic 
Script
This section explains how to extract the BEA WebLogic Adapter for PeopleSoft 8 jar file and edit 
your WebLogic script to add files to the CLASSPATH and adjust the PATH.

Note: For WebLogic Integration 8.1 SP2, the script file you edit is setDomainEnv.cmd or 
setDomainEnv.sh. For versions of WebLogic Integration, earlier than 8.1 SP2, the file 
name is startWeblogic.cmd or startWebLogic.sh.

Set the classpath using the procedure appropriate for your system:

Extracting Files and Adjusting the Classpath for Windows

Extracting Files and Adjusting the Classpath for UNIX

Extracting Files and Adjusting the Classpath for Windows
To extract the BEA WebLogic Adapter for PeopleSoft 8 files and edit the WebLogic script:

1. Use WinZip (or another similar extracting product) to extract the BEA_PEOPLESOFT_8_1.ear 
file to a directory of your choice (for example, BEA_HOME\adapters\peoplesoft).

http://commerce.bea.com/products/weblogicadapters/wl_adapter_home.jsp
http://edocs.bea.com/platform/docs81/confgwiz/index.html


I ns ta l l ing  the  Adapte r

BEA WebLogic Adapter for PeopleSoft 8 Installation Guide 1-5

2. Find the PeopleSoft Java Object Adapter jar file psjoa.jar in your PS_HOME directory. 
Both the adapter and the BEA Application Explorer need this file to work with PeopleSoft. 
Copy this file to the directory where you extracted the adapter ear file. If you have the BEA 
Application Explorer installed, copy this file also to the BEA Application Explorer \lib 
directory.

Note: The PeopleSoft Java Object Adapter jar file is specific to your release of PeopleSoft. 
As part of any upgrade of your PeopleSoft release, you must also upgrade the file used 
by the adapter and the BEA Application Explorer. To do this, shut down WebLogic 
Server, copy the new psjoa.jar file into the directory that contains the adapter ear 
file, and also to the BEA Application Explorer \lib directory, and start WebLogic 
Server up again.

3. If you are using PeopleSoft 8.1x, you also need the pstools.properties file. You can 
find this file in your PS_HOME directory. Copy the pstools.properties file to the 
directory that contains the adapter ear file. If you have the BEA Application Explorer 
installed, copy this file to the BEA Application Explorer \lib directory.

4. Go to the root directory for your domain:

cd DOMAIN_HOME

Note: You must choose a domain that supports application integration functionality. 

5. Open the WebLogic script file with an ASCII editor. For WebLogic Integration 8.1 SP2, the 
file is setDomainEnv.cmd. For earlier versions of WebLogic Integration, the file is 
startWebLogic.cmd.

6. Find the following command in the script file:

set CLASSPATH=%ARDIR%\ant\ant.jar;%JAVA_HOME%\jre\lib\rt.jar

7. Immediately after this command line, insert the following lines so that the CLASSPATH and 
PATH point to the adapter files:

rem ==== PeopleSoft Java Libraries and DLLs (for JNI calls) ====
set CLASSPATH=%CLASSPATH%;BEA_HOME\adapters\peoplesoft\psjoa.jar
set CLASSPATH=%CLASSPATH%;BEA_HOME\adapters\peoplesoft\psclasses.jar

Note: psclasses.jar is a file that you must generate. See the BEA WebLogic Adapter for 
PeopleSoft 8 User Guide for instructions on generating this file.

In the following line, replace the nn with the number of your PeopleSoft release. For 
example, If you use PeopleSoft 8.1, the file name is PS_BEA_CI81.jar. If you use 
PeopleSoft 8.4, the file name is PS_BEA_CI84.jar.

set CLASSPATH=%CLASSPATH%;BEA_HOME\adapters\peoplesoft\PS_BEA_CInn.jar
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If you use PeopleSoft 8.1, add the directory containing the pstools.properties file to 
the classpath.

set CLASSPATH=%CLASSPATH%;BEA_HOME\adapters\peoplesoft

8. Place the component interface API files in the classpath. For information on compiling the 
PeopleSoft API Java programs, see the BEA WebLogic Adapter for PeopleSoft 8 User 
Guide.

9. Save your changes and close the script file.

Extracting Files and Adjusting the Classpath for UNIX
To extract the BEA WebLogic Adapter for PeopleSoft 8 files and edit the WebLogic script:

1. Use jar (or another similar extracting product) to extract BEA_PEOPLESOFT_8_1.ear to a 
directory of your choice (for example, BEA_HOME/adapters/peoplesoft).

2. Find the PeopleSoft Java Object Adapter jar file psjoa.jar in your PS_HOME directory. 
This file is part of your PeopleSoft distribution. Both the adapter and the BEA Application 
Explorer need this jar file to work with PeopleSoft. Copy this file to the directory where you 
extracted the adapter ear file. If you have the BEA Application Explorer installed, copy this 
file also to the BEA Application Explorer /lib directory (Windows).

Note: The PeopleSoft Java Object Adapter jar file is specific to your release of PeopleSoft. 
As part of any upgrade of your PeopleSoft release, you must also upgrade the file used 
by the adapter and the BEA Application Explorer. To do this, shut down WebLogic 
Server, copy the new psjoa.jar file into the directory that contains the adapter ear 
file and also to the BEA Application Explorer /lib directory, and start WebLogic 
Server up again.

3. If you are using PeopleSoft 8.1x, you also need the pstools.properties file. You can 
find this file in your PS_HOME directory. Copy the pstools.properties file to the 
directory that contains the adapter ear file. If you have the BEA Application Explorer 
installed, copy this file also to the BEA Application Explorer /lib directory.

4. Find the tools.jar file in your JDK directory.

5. Go to the root directory for your domain: 

cd DOMAIN_HOME

Note: You must choose a WebLogic Integration domain that supports application 
integration functionality. 
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6. Open the WebLogic script file with an editor. For WebLogic Integration 8.1 SP2, the file is 
setDomainEnv.sh. For earlier versions of WebLogic Integration, the file is 
startWebLogic.sh.

7. Find the PRE_CLASSPATH variable.

8. Add the path to the tools.jar file to the PRE_CLASSPATH variable.

9. Update the CLASSPATH environment variable settings in the script file.

After the following line: 

CLASSPATH="${ARDIR}/ant/ant.jar:${JAVA_HOME}/jre/lib/rt.jar"

add the following JAR files:

CLASSPATH=$CLASSPATH:BEA_HOME/adapters/peoplesoft/psjoa.jar

CLASSPATH=$CLASSPATH:BEA_HOME/adapters/peoplesoft/psclasses.jar

Note: psclasses.jar is a file that you must generate. See the BEA WebLogic Adapter for 
PeopleSoft 8 User Guide for instructions on generating this file.

In the following line, replace the nn with the number of your PeopleSoft release. For 
example, If you use PeopleSoft 8.1, the file name is PS_BEA_CI81.jar. If you use 
PeopleSoft 8.4, the file name is PS_BEA_CI84.jar.

CLASSPATH=$CLASSPATH:BEA_HOME/adapters/peoplesoft/PS_BEA_CInn.jar

If you use PeopleSoft 8.1, add the directory containing the pstools.properties file to 
the classpath.

CLASSPATH=$CLASSPATH:BEA_HOME/adapters/peoplesoft

10. Place the component interface API files in the classpath. For information on compiling the 
PeopleSoft API Java programs, see the BEA WebLogic Adapter for PeopleSoft 8 User 
Guide.

11. Save your changes and close the script file.

Step 4. Update the BEA License
In order to use the BEA WebLogic Adapter for PeopleSoft 8 you must have a valid software 
license. If you have downloaded the adapter for evaluation, see the instructions on the adapter 
download page to obtain an evaluation license. If you have purchased a license for the adapter, 
you should receive the license file as an e-mail attachment. Once you have the license file for the 
adapter, you must update your license.bea file to include the new information for the adapter.
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To update your license.bea file:

1. Save the adapter license file in the BEA_HOME directory. To avoid overwriting your 
license.bea file, use a name other than license.bea. For example, save the file as 
peoplesoft_adapter_license.bea. The adapter license file is the 
license_update_file referred to in step 4 of this procedure. 

Warning: Do not overwrite or change the name of the existing license.bea file. 

2.  Go to the BEA_HOME directory: 

– On a Windows system, open an MS-DOS session and go to the BEA_HOME directory. 

– On a UNIX system, go to the BEA_HOME directory. 

3. Add the JDK to your PATH variable. If it is already included, skip to step 4.

– On a Windows system:

set PATH=BEA_HOME\jdk141_03\bin;%PATH%

– On a UNIX system:

PATH=BEA_HOME/jdk141_03/bin:$PATH
export PATH

4. Merge the adapter license file into your existing license:

– On a Windows system: 

UpdateLicense license_update_file

– On a UNIX system: 

sh UpdateLicense.sh license_update_file

Here, license_update_file is the name of the adapter license file you saved in step 1.

5. Save a backup copy of your updated license.bea file. This backup location should be a 
safe place that is neither the WebLogic Integration nor the application installation 
directories. 

Step 5. Deploy the Adapter
After you have installed the BEA WebLogic Adapter for PeopleSoft 8, you must deploy it to your 
domain. 

To deploy the adapter:

1. Start WebLogic Server in your domain.
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2. Start the WebLogic Server Administration Console in a browser using the following URL: 

http://host:port/console/ 

where

– host represents the machine on which WebLogic Server is running

– port represents the listening port. 

For example, http://localhost:7001/console/

3. Enter the user name and password for the server.

The WebLogic Server Administration Console appears.

4. In the left pane, expand the Deployments node.

5. Under the Deployments node, click the Applications node.

The Administration Console displays the Applications window.

6. Click the Deploy a new Application link.

The Administration Console displays the Deploy an Application window.

7. Click the upload your files(s) link.

The Administration Console displays the Install or Update an Application window.

Click to deploy a new application.

Click to upload 
your files 
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8. Click the Browse button, navigate to the directory in which the BEA_PEOPLESOFT_8_1.ear 
file resides, and then click the Upload button.

The Administration Console prompts you to confirm the uploaded application.

9. Click the radio button next to the application file and then click Continue.

The Administration Console uploads the file and displays the Deploy an Application 
window (in which the default target server is specified).

10. Click the Deploy button.

The Administration Console deploys the application and displays its deployment status.

Click to browse

Click to deploy
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Step 6. Create an Adapter Administrative User
If you want to manage security for the BEA WebLogic Adapter for PeopleSoft 8, you can create 
an administrative user (such as peoplesoftAdapterAdmin) who is authorized to log in to the 
Application View Console, create application views, configure services and events, deploy, and 
test. This adapter administrator also needs to be added to the Administrators group.

To create a new adapter administrative user:

1. In the left pane of theWebLogic Server Administration Console, click the Security node.

2. In the left pane, click the Realms node.

3. In the left pane, click the name of the realm for which you want to configure security.

4. In the left pane, click Users. 

The Users page opens.

5. Click the Configure a New User link. 

The Create User page opens.

When this status is 
success, you can 
go to the next step.
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6. Enter the user name, description and password, and then click the Apply button. 

The User page opens.

7. Click the Groups tab. 

The Groups page opens.

8. In the Possible Groups list, select Administrators and then click the right arrow to add the 
Administrators group to the list of current groups.

Enter the 
user 
information.

Enter a 
description for 
this user.
Click to change 
the password.

Select a group for 
the user.
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9. Click the Apply button.

10. In the left pane, click the Users node and confirm that the user you created appears in the 
list of users.

Next Steps
After you have finished installing the BEA WebLogic Adapter for PeopleSoft 8, you can proceed 
to the following tasks:

Installing the Component Interfaces

Installing the BEA Application Explorer

Starting Integration with PeopleSoft

Installing the BEA Application Explorer
To proceed, you must install the BEA Application Explorer. If you do not already have it 
installed, do so now. To learn more about installing the BEA Application Explorer, see the BEA 
Application Explorer Installation and Configuration Guide at the following URL:

http://edocs.bea.com/wladapters/docs81/index.html

Starting Integration with PeopleSoft
After you have successfully installed and deployed the BEA WebLogic Adapter for PeopleSoft 
8 and the BEA Application Explorer, you can begin integrating with your PeopleSoft system 
using the adapter and BEA WebLogic Integration. To learn more about integrating with 
PeopleSoft, see the BEA WebLogic Adapter for PeopleSoft 8 User Guide at the following URL:

http://edocs.bea.com/wladapters/docs81/index.html

http://edocs.bea.com/wladapters/docs81/index.html
http://edocs.bea.com/wladapters/docs81/index.html
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C H A P T E R 2

Installing the Component Interfaces

The PeopleSoft component interfaces contain metadata that the BEA Application Explorer uses 
to generate schemas for the PeopleSoft services and events used by your application. The adapter 
distribution contains two such component interfaces. You must install these files to enable the 
BEA Application Explorer to properly generate schemas.

This section explains:

Extracting and Importing the Component Interface Files

Configuring Security for the Component Interfaces

Testing the Component Interfaces

Extracting and Importing the Component Interface Files
This section explains how to extract and import the component interface files so that the BEA 
Application Explorer can use them.

To learn more about the BEA Application Explorer, see the BEA Application Explorer 
Installation and Configuration Guide at the following URL:

http://e-docs.bea.com/wladapters/bae/docs81/pdf/install.pdf

http://e-docs.bea.com/wladapters/bae/docs81/pdf/install.pdf
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This section is organized as follows:

Extracting the Component Interface Files

Importing the Component Interface Files into PeopleSoft

Extracting the Component Interface Files
There are two component interface files included in the adapter distribution. The first step is to 
extract them from the adapter ear file, BEA_PEOPLESOFT_8_1.ear.

Extracting the Files on Window System
To extract the files on a Windows system:

1. Using WinZip, or another extraction utility, extract the project file from the adapter ear file:

– For PeopleSoft.1x, the file is BEA_CI_81.zip

– For PeopleSoft.4 and higher, the file is BEA_CI_84.zip

Extract the project file to a directory of your choice.

The extraction process creates a subdirectory with the same name as the project file. For 
example, if you extract the PeopleSoft.4 project file into the Windows directory 
c:\adapters, you will see this directory: c:\adapters\BEA_CI_84.

Extracting the Files on a UNIX System
To extract the files on a UNIX system:

1. Using jar or another extraction utility, extract the project file from the adapter ear file:

– For PeopleSoft.1x, the file is BEA_CI_81

– For PeopleSoft.4 and higher, the file is BEA_CI_84

Extract the project file to a directory of your choice.

The extraction process creates a subdirectory with the same name as the project file. For 
example, if you extract the PeopleSoft.4 project file into the UNIX directory /adapters, 
you will see this directory: /adapters/BEA_CI_84.

Importing the Component Interface Files into PeopleSoft
The component interface files are a PeopleSoft project. In order to use them, you must import this 
project into your PeopleSoft installation.
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These are the steps for importing your project into PeopleSoft:

Copying the Component Interface Files into PeopleSoft

Building the Component Interface Project in PeopleSoft

Copying the Component Interface Files into PeopleSoft
After you have extracted the project files, the next step is to copy them into PeopleSoft.

To copy the component interface files:

1. Start the PeopleSoft Application Designer in two-tier mode.

2. Copy the project into PeopleSoft from the file.

– In PeopleSoft.1, Select File→Copy Project from File.

The Copy Project From File dialog appears.

– In PeopleSoft.4, select Tools→Copy Project→From File...

The Copy From File: Select Project dialog appears.

3. Go to the directory where you extracted the project file. Using the example above, that is 
c:\adapters\BEA_CI_84. 

4. Open the Copy dialog.

– In PeopleSoft.1, select the file and click Copy.

Go to the directory where you extracted the project.

Choose the project.

Click to copy the file.

Click to open the file.

Go to the directory where you extracted the project.

Choose the project.

Choose the file.
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– In PeopleSoft.4 select the file and the project. Click Open.

The Copy From File dialog appears.

5. Make sure all the definition types are selected. Click copy to copy these definition types 
into your PeopleSoft installation.

When this copy is successfully completed, a copy ended message appears in the bottom 
pane of the Application Designer window.

Building the Component Interface Project in PeopleSoft
After you have copied the files into PeopleSoft, the next step is to build the project. 

To build the project:

1. Choose Build → Project

The Build dialog appears.

2. Select Create Views. Select the build execute option that is standard for your PeopleSoft 
installation. Click Build.

A progress indicator appears.

Make sure all the definition types 

Click to copy the definition types.

Click to build the project

Select Create Views.

Select the build execute option that is 
standard for your PeopleSoft 8 installation.
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Note: When the build is done, you can use your native SQL tool to look at the views that 
the build created.

3. Click Close to close the build progress indicator.

Troubleshooting the Build
If the build generated errors, you must troubleshoot the build to find and correct the errors. 

1. In the bottom pane of the application designer window, double-click the line that begins: SQL 
Build log written

The SQL build log appears.

2. Choose Build → Settings.

The build settings dialog appears.

3. Make sure the build setting are correct for your PeopleSoft installation. 

Note: Your installation may use a database that requires you to specify the tablespace name. 
Consult your PeopleSoft administrator for this information. 

4. Click OK. 

5. Restart the build. See Building the Component Interface Project in PeopleSoft.

When the settings are correct for your 
PeopleSoft installation, click OK.
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Configuring Security for the Component Interfaces
Now that the component interfaces are copied into your PeopleSoft installation and built, you 
must configure the security for them. To configure security, you must set the component interface 
security for each distinct Permission List belonging to users who will be using the component 
interfaces.

For PeopleSoft.1, you can set 2, 3, or 4-tier mode security. For PeopleSoft.4 and higher you can 
set 4-tier mode security. The process is the same for all supported release levels.

To configure security for the component interfaces:

1. Choose PeopleTools→Security→User Profiles→Permissions & Roles→Permission Lists.

The permission lists window appears.

2. Click Search. 

3. Select a permission list.

The page for that permission list appears.

Click to search.

Select a 
permission list.
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4. On the right side of the row of tabs, click the right arrow. This arrow is next to the Sign-On 
Times tab. This displays the Component Interfaces tab.

5. Click the Component Interfaces tab. 

This page lists the component interfaces for the permission list you selected.

6. Click the + button to add a new component interface to the list.

7. Browse and select the BEA_CI_ATTRIBUTES component interface. Click Upload.

The Component Interface Permissions window appears.

Click on this arrow to 
display the component 
interface tab.
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8. Under Method Access, choose for both the Find and Get methods. Click OK.

9. Repeat steps 6 through 8 to add the BEA_CI_MESSAGES component interface and set 
permissions for it.

10. When you have added the component interfaces, click Save at the bottom of the component 
interfaces window.

Testing the Component Interfaces
Once you have the component interfaces installed and security set, you must test the interfaces. 
The testing process involves opening each component interface individually in the Application 
Designer and executing its Find and Get methods.

To test the component interfaces:

1. In the Application Designer, open the BEA_CI_ATTRIBUTES component interface.

2. Choose Tools → Test Component Interface.

The Component Interface Test dialog appears.

Note: Notice that the Create New option is disabled. This is correct. The add method does 
not apply to the BEA_CI_ATTRIBUTES component interface.

3. Click Find.

Select Full Access.

Click to see the list of keys.
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The list of keys for the component appear.

Note: You may see an error message indicating a limit on the number of entries that can be 
displayed. This does not have any effect on your test. 

4. Highlight a key and click Get Selected.

A window with the details for the selected key appears.

You have successfully tested the component’s Find method.

5. In the Component Interface Tester window, click Get Existing. To test the get method, you 
must supply an existing key.

Highlight a key and click to 
see the details of that key.
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The properties for that key appear.

You have successfully tested the Get method.

6. Repeat this process for the remaining component interfaces included with the adapter.

Next Steps
To continue configuring the adapter, see Chapter 3, “Installing and Configuring the BEA TCP/IP 
Message Router.”

Click to start testing the get method.
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C H A P T E R 3

Installing and Configuring the BEA 
TCP/IP Message Router

The BEA TCP/IP message router allows PeopleSoft to send XML event documents to your 
application using TCP/IP. The process of enabling this involves installing the software and 
configuring the PeopleSoft application gateway.

This section is organized as follows:

Installing the BEA TCP/IP Handler for PeopleSoft 8.1

Installing the BEA TCP/IP Target Connector for PeopleSoft 8.4 and Higher

Installing the BEA TCP/IP Handler for PeopleSoft 8.1
This section explains how to install the BEA TCP/IP handler for PeopleSoft 8.1.

This process has the following steps:

Extracting and Installing the BEA TCP/IP Handler

Configuring the BEA TCP/IP Handler for the PeopleSoft Gateway Server-

Note: To learn more about installing and configuring the BEA TCP/IP target connector for 
PeopleSoft 8.4, see “Installing the BEA TCP/IP Target Connector for PeopleSoft 8.4 and 
Higher.”
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Extracting and Installing the BEA TCP/IP Handler
The BEA TCP/IP handler is included in the adapter ear file. It is the iwpsevent81.jar file.

To extract and install the BEA TCP/IP handler:

1. On the machine where you placed the adapter ear file, extract the BEA TCP/IP handler jar 
file: iwpsevent81.jar.

2. Log on to the machine running PeopleSoft, using valid a PeopleSoft ID and permissions.

3. Go to the PeopleSoft Web servlets directory. The exact location of this directory may vary 
from release to release. However, in general:

– On Windows, it is %PS_HOME%\webserv\servletclasses

– On UNIX, it is $PS_HOME/webserv/servletclasses

4. Copy the TCP/IP handler jar file to the servlets directory.

5. Extract classes from the TCP/IP handler jar file, iwpsevent81.jar using WinZip, jar, or a 
similar extraction utility.

The files are extracted in a new directory, tcphandler. On Windows, this file is under 
psft\pt8. On UNIX, this is under psft/pt8.

Configuring the BEA TCP/IP Handler for the PeopleSoft 
Gateway Server
To configure the BEA TCP/IP handler gateway server:

1. Start the PeopleSoft configuration servlet interface (server gateway). The location of this 
servlet may vary from release to release. It is generally located here:
http://serverURL/servlets/gateway.administration

Here, serverURL is the URL of the PeopleSoft server.

The PeopleSoft handler directory window appears.

2. Click Add Handler to add a new handler to the list.
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The Add Handler window appears.

3. Enter the name of the BEA TCP/IP handler class: 

psft.pt8.tcphandler.TCPIPHandler81

4. Click Save.

The status window appears. Note the status is Not Loaded.

5. Click Load. This activates the handler. The gateway servlet loads the Java class you 
specified. 

If the gateway servlet finds the class at the path you specified and loaded it successfully, 
the status becomes Loaded successfully.

If the gateway servlet throws a ClassNotFoundException, it failed to find the class you 
indicated at the path you indicated. Make sure the classpath is correct. If you change this, 
you may need to stop and restart your Web server.

Sometimes you may need to deactivate a handler during production. To do this, click 
Unload. Once unloaded, the handler cannot receive or process messages published by the 
gateway server.

6. Click Configure.

The table view appears.
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7. Click Add a TCPIP81 node.

The TCPIP81 Handler window appears.

8. Enter the values for the TCP/IP Handler:

– Node name: the name of the node to add, such as BEA_MSGNODE.

– Host name: the name of the host running the BEA WebLogic Integration server.

– Port: the TCP port specified when you added the application view event.

– Trace directory: the directory where the trace file is written. Trace files contain 
information about any problems with message delivery.

9. Click Save.

The TCPIP Handler window shows the new TCP/IP message handler.

You have successfully configure the BEA TCP/IP Handler.
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Installing the BEA TCP/IP Target Connector for PeopleSoft 8.4 
and Higher

For PeopleSoft 8.4, the TCP/IP handler is called the TCP/IP target connector. 

This section is organized as follows:

Extracting and Installing the Target Connector

Creating a Gateway

Extracting and Installing the Target Connector
The class file for this component is included in the adapter ear file. The TCP/IP target connector 
is in the TCPIPTarget84.class file.

To extract and install the target connector:

1. On the machine where you placed the adapter ear file, use WinZip, jar of a similar extraction 
utility to extract the BEA TCP/IP target connector class file from the jar file: 
iwpsevent84.jar.

2. Log on to the machine running PeopleSoft, using valid a PeopleSoft ID and permissions.

3. Go to the PeopleSoft gateway Web server target connector directory. The exact location of 
this directory may vary from release to release. However, in general:

– On Windows for WebLogic, it is: 

c:\bea\wlserver8.1\config\peoplesoft\applications\PSIGW\Web-inf\classes\com\
peoplesoft\pt\integrationgateway\targetconnector

– On UNIX for WebLogic, it is: 

/bea/wlserver8.1/config/peoplesoft/applications/PSIGW/Web-inf/classes/com/
peoplesoft/pt/integrationgateway/targetconnector

– On Windows for WebSphere, it is: 

c:\websphere\AppServer\installedApps\peoplesoft\PSIGW\Web-inf\classes\com\
peoplesoft\pt\integrationgateway\targetconnector

– On UNIX for WebSphere, it is: 

websphere/AppServer/installedApps/peoplesoft/PSIGW/Web-inf/classes/com/
peoplesoft/pt/integrationgateway/targetconnector

4. Copy the TCP/IP target connector class file to the target connector directory.
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Creating a Gateway
To create a gateway:

1. Choose PeopleTools→Integration Broker→Gateways.

The Gateway URL window appears.

2. Find the local gateway. Enter the URL for this gateway in the gateway URL field. 

Note: The gateway URL is set during installation.

3. Click Load.

The Connector properties window appears.

Note: The connector properties are predefined during Integration Broker installation.

4. The status window appears. Click OK to dismiss this window.

The connector TCPIPTARGET84 appears in the connectors list.
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5. Enter the gateway URL.

The Gateway Window appears.

You have successfully configured the gateway.
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